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Adding a Macro to Connexion Client:  082to092 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



ANNOUNCEMENTS 
 
 

Reminder to Print or Save the June OPUS Report 
 
You may remember that last October, OCLC introduced a new online statistical report called OCLC 
Product Usage Statistics (OPUS).  The OPUS report cumulates information for the fiscal year (July-
June) and each month’s report overwrites the previous report.  So, if you want to archive the 
data, you need to print out or download the report.  The June report (available July 8) is the 
crucial one to save since it will contain data for the full 2003/2004 and 2004/2005 fiscal years. 
 
Available from the OCLC Product Services Web, the OPUS report contains statistics for every OCLC 
product code your institution uses.  You can view the report online or download a tab-delimited 
version for use in spreadsheet or database software.  OPUS replaced the quarterly Marketing 
Usage Trends Reporting System (MUTRS) reports that used to be included with your 
MINITEX/OCLC statements.   
 
Available from the OCLC Web site, the OPUS report contains statistics for the current and previous 
fiscal years, including every product code that your institution uses (unlike MUTRS which only 
covered 128 product codes).  The report is available in a Web-viewable format as well as in a tab-
delimited downloadable format, so you can plug the data into a spreadsheet application and 
crunch numbers to your heart’s content. 
 
The OPUS reports are available on the 8th of each month by 5 p.m. Eastern time.  To access 
OPUS, go to: 

<http://psw.oclc.org>  
Click on Records and Reports, click on the link for OCLC Product Usage Statistics, and enter a valid 
OCLC authorization and password.  
 
Carla Dewey Urban, MINITEX 
 
 
 
 
 

GENERAL 
 
 

New Union List Migration Website 
 
On June 24, OCLC announced the availability of a new website that gives information about the 
upcoming migration of Union Listing functionality to the Connexion Browser service.  At this point, 
the official word is that OCLC plans to migrate Union Listing to Connexion in the last quarter of 
2005, but no specific date for the change has been scheduled. 
 

http://psw.oclc.org
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To read the most recent information about the Union List Migration project, go to the OCLC 
website: 

<http://www.oclc.org/unionlist/migration/default.htm> 
 
You can also click to this page from the OCLC Union List page: 

<http://www.oclc.org/unionlist/default.htm> 
 
Several changes will accompany this change of service at OCLC: 
 

•  The Connexion Browser will be updated to allow editing and creation of Union List 
holdings records.  These records can already be viewed via OCLC FirstSearch and 
WorldCat Resource Sharing, but until the migration, they can only be updated via 
the Passport UL service. 

 

•  Union List holding format will be adjusted to conform to the MFHD holdings format.  
Holdings statements currently in OCLC are to be converted to the new format, 
which should allow easier transfer of holdings information between OCLC and other 
library systems. 

 

•  Serials Offline Products, including printouts of individual library holdings, will be 
revised to provide products designed to meet the needs of libraries in the current 
environment.   

 
Other changes will be made on an ongoing basis to incorporate local holdings information into 
other OCLC products and services. 
 
As these changes are announced (and later as we approach the actual migration), you can count 
on the MINITEX MULS unit to help keep you informed and prepared for the new system.  We will 
be creating and presenting workshops on Union Listing topics, like the new Union List Connexion 
interface and the MARC 21 Format for Holdings Data this fall.  If you have questions, feel free to 
contact Dave Linton or Cecelia Boone and we will be happy to share what we know (see contact 
information at the end of this Mailing). 
 
Dave Linton, MINITEX 
 
 
 
 
 

CATALOGING & METADATA 
 
 

Good-bye AACR, Hello RDA 
 
AACR (Anglo-American Cataloging Rules) has been the cataloger’s “bible” for close to four 
decades.  Our most recent companion has been AACR2 and its many revisions. Now, the JSC 
(Joint Steering Committee for revision of AACR), along with input from the cataloging community, 

http://www.oclc.org/unionlist/migration/default.htm
http://www.oclc.org/unionlist/default.htm
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has decided it is time for a new direction.  There will be no AACR3.  Instead, a new publication is 
being planned:  Resource Description and Access (RDA). 
 
Yikes!  Are we going to have to re-catalog everything?  No, thank goodness.  The new publication 
will use many of the old rules.  However, everything will be reorganized, simplified, tweaked, and 
enhanced to reflect new principles, new formats (e.g. electronic), etc.  As the JSC Website says, 
“what is being developed is in effect a new standard for resource description and access, designed 
for the digital world.” 
 
But don’t hold your breath!  This new cataloging guide is not expected to be ready until 2008.  
Meanwhile, the final update to AACR2 (the 2005 update to the 2002 revision) has just been 
published. 
 
To find out more about RDA, and to follow its progress, go to the JSC Website at: 

<http://www.collectionscanada.ca/jsc/index.html> 
 
To order the 2005 Update to the 2002 revision of AACR2, go to the ALA Online store at: 

<http://www.alastore.ala.org/> 
 
Virginia Dudley, MINITEX BATS 
 
 
 

Connexion Client 1.40 Enhancements Coming in July 
 
Version 1.40 is set to be released sometime in July.  Listed below is a preview of the 
enhancements.  To view other future enhancements for later versions you can visit: 
 http://www.oclc.org/connexion/interface/client/enhancements/future.htm 
 

•  Select Cataloging using Hebrew, Cyrillic, and Greek scripts 
 You can already preview the first Cyrillic, Hebrew, and Greek script records added 

to WorldCat! 
 Cyrillic record, OCLC #60678907 
 Hebrew record, OCLC #60690901 
 For a Greek record, OCLC #9355323 

 

•  Spell check 
 Verify English language spelling in bibliographic and authority records. Choose 

between Canada, Great Britain, and United States English dictionaries. Customize 
the user dictionary, and specify fields to check and subfields to exclude. Import the 
content of the user dictionary and field settings from the spell checker used with 
Passport or CatME, if desired. 

 

•  Offline validation 
 Validate records when working offline. Offline validation verifies all data in the 

record, as is done with online validation. Previously with CatME, CJK, and Arabic 
software, the offline validation was a small subset of the full validation process, so 
some records passed offline validation and then failed online validation. You do not 

http://www.collectionscanada.ca/jsc/index.html
http://www.alastore.ala.org/
http://www.oclc.org/connexion/interface/client/enhancements/future.htm
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need to be logged on to Connexion to do this validation; however, your workstation 
must have access to the Internet. 

 

•  Local file sort 
 Sort the bibliographic local file by call number, and view the call number in the local 

file list.  When sorting the bibliographic local file by title, ignore initial characters 
based on the 245 filing indicator. 

 

•  Local accessions list 
 Print records in "accessions list" format to create lists of your newly cataloged 

items. Sort a local file list in the order in which you want to print the entries in the 
accessions list, select the records, and print the list to a printer or to an HTML file. 
Sort options include call number, control number, date/time added to file, name, 
save file number, title, or any column in the local file list. 

 

•  Batch searching and processing enhancements 
 When entering batch search keys, specify a default index label to be used with 

searches entered or imported.  When batch searching, specify a My Status value to 
be added to all records downloaded to the local file. 

 

•  Authorities 
 When using the Authorities Drop-down menu, you will have the option of searching 

LC Names and Subjects 
 

•  Text strings  
 Apply text strings to records that include complete fields or multiple fields, and the 

cursor is left at the end of the string so you can continue typing additional data. 
 

•  Access WebDewey 
 Launch WebDewey from the Connexion client, which opens your browser and 

automatically logs you onto WebDewey using your default authorization number 
and password. 

 

•  Access OCLC Usage Statistics 
 Launch OCLC Usage Statistics from the Connexion client to view statistics 

describing your use of Connexion. The client opens your browser and automatically 
logs you on to the statistics page using your default authorization number and 
password. 

 

•  Chinese (Simplified), Chinese (Traditional), and Japanese interfaces 
 Select Chinese (Simplified), Chinese (Traditional), or Japanese as your interface 

language, or select English or Spanish, which are currently supported in client 1.30. 
(Note: OCLC expects that these new interface languages will be included with client 
1.40 in July; however, this will be confirmed at a later time.) 

 

•  Arabic script align-right option 
 Select an option to view Arabic script data aligned on the right side of the screen, 

with Latin script aligned on the left side. 
 

•  Access to the Chinese Name Authority File 
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 Access the Chinese Name Authority File to search for Chinese authority records and 
copy data to paste into bibliographic records. 

 
•  Problem resolutions 

 Resolutions to several reported problems as listed in the Known Problems 
document. (Note: the list of resolved problems is current, but more problems may 
be resolved prior to the client 1.40 release. The Known Problems list will continue 
to be updated.) 

 
OCLC; edited 
 
 

 
Macro of the Month 

 
When cataloging using OCLC Connexion Client, do you manually type in or copy the Dewey 
number from the 082 field to your locally assigned call number field 092? Have you thought about 
creating a macro to automatically copy and paste this information into the correct MARC field?  
The macro featured this month takes the 082 field and inserts the Dewey call number into the 092 
field.  Detailed instructions on how to add this macro are included as an attachment at the end of 
the Mailing.   This macro was created by Joel Hahn of the Niles Public Library District, and 
obtained from his website at: 
 <http://users.rcn.com/aardy/oml/connex.html> 
 
Sara Ring, MINITEX 
 
 
 

Connexion Client Tip:  Record Display 
 

An OCLC Connexion Client user wrote to the OCLC-CAT list: 
 
Question:  In Connexion, is there a way to display a record single-spaced so more of it fits on 
one page? 
 
Answer:  A neat feature in Connexion is the option to not "view all field data".  If you go into 
Tools > Options > Record Display and deselect the check box next to "View All Field Data", any 
field over about 4 lines (depends on your screen resolution) will get its own personal scroll bar. 
It's nice for long 505 and 520 fields. 
 
The other thing you can try is changing your display font. A smaller font will, in turn, make the 
fields smaller.  To do this go to Tools > Options > Fonts.   
 
You can also choose to display your fixed fields at the bottom of the record, clearing up more 
space at the top when you're editing. You can change this in View > OCLC Fixed Field > 
Top/Bottom/Fixed Fields. Choose "Bottom," and it will automatically move to the bottom of your 
screen. 

http://users.rcn.com/aardy/oml/connex.html


MINITEX/OCLC Mailing, July 2005 
 6

 
The last thing I suggest is making sure that the screen resolution on your monitor is at least 1024 
x 768. If you are at 800 x 600, everything looks more crowded. 
 
Even after making all of these changes, many records will require a bit of scrolling in Windows. 
 
Keri Cascio, MLNC; edited (posted on OCLC-CAT on 6/29/2005) 
 
 

 
OCLC Connexion Changes 

 
You may have noticed when updating records using the Connexion Client that validation 
intermittently fails.  This may be due to some changes that OCLC made to the Connexion system 
in early June.  There are two known validation problems that were resolved by OCLC recently: 
 

•  010 Field 
 A fix was installed to suppress the validation error generated for some post-2000 

LCCNs (4-digit year) when there was an extra space after the last digit.  If the extra 
space is present, the system will no longer give you the validation error "1st $a in 1st 
010 is too long". 

 
•  007 Field 

 OCLC is working on identifying all records that have duplicate 007’s so they may 
correct them.  If all goes according to schedule, this problem will be fixed after an 
update on July 10.    

 
In addition, there is one more change of which you should be aware.  The system is now 
requiring the correct number of digits for each of these fields:  10 for 020; 13 for 024 first 
indicator 3 (EAN); 12 for 024 first indicator 1 (UPC).  However, a number of people have reported 
that there seems to be something else going on with the 024 field that causes it to fail validation, 
and OCLC is looking at it to see if they should be making any changes.  Meanwhile, if the field has 
qualifying information such as *pbk*, try removing that to get the field to validate. 
 
If you are having other validation errors not listed here when you update your records, please do 
not hesitate to contact us at the BATS unit (contact information listed at the end of the Mailing). 
 
Virginia Dudley, MINITEX; Sara Ring, MINITEX 
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RESOURCE SHARING 
 
 

OCLC Resource Sharing Statistics 
 
All OCLC resource sharing statistics have been moved from Product Services Web to OCLC Usage 
Statistics at:  

<http://www.stats.oclc.org>  
 
The OCLC Usage Statistics include the following reports:  
 

•  ILL Fee Management Program Borrower Report 
•  ILL Fee Management Program Lender Report 
•  ILL Borrower Reasons For No Report 
•  ILL Lender Reasons For No Report 
•  Borrower ILL Management Stats Report 
•  Lender ILL Management Stats Report 
•  Strategic Union List Report 
•  Borrower Overview Report 
•  Lender Overview Report 
•  Borrower Detail Report 
•  Lender Detail Report 

 
All reports are available to all users of OCLC Resource Sharing. Use your resource sharing 
authorization and password to access reports. These reports may be exported for manipulation in 
Microsoft Excel. 
 

When Things Go Wrong 
 
If you encounter slow response times, down time, or system glitches using WorldCat 
Resource Sharing and Connexion, you can learn whether the problem has been reported 
to OCLC by visiting the System Alerts Page at: 

http://www.oclc.org/support/systemalerts/ 
If you do not see the problem reported there, then chances are that OCLC does not 
know about the problem.  Please give the BATS unit a call if you experience any of these 
problems, and we can work with you to determine if the problem is local or system wide 
(see contact information at the end of this Mailing). 

 

http://www.stats.oclc.org
http://www.oclc.org/support/systemalerts/
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OCLC will not add any ILL reports to Product Services Web after the June reports. Records and 
Reports are on OCLC Product Services for 90 days after the day of posting, and, in September, ILL 
reports will be discontinued on Product Services Web. OCLC Usage Statistics will be kept for 18 
months once 18 months worth of data has been collected. 
 
 
 
 
 

REFERENCE  
 
 

OCLC FirstSearch Service Databases 
 
The latest edition of this semiannual publication is now available.  A six-page table in this 
publication provides information on full text availability, links to library OPACs, ordering options 
and suggested audiences (by library type) for each database.  Capsule descriptions of each 
database include producer information, update frequency, number of records and time period 
covered. 
 
OCLC FirstSearch Service Databases is also available in Spanish and French.  To request copies of 
this publication, contact the BATS unit (contact information at the end of this Mailing).  The same 
information found in these printed publications is also available online, at: 

<http://www.oclc.org/support/documentation/firstsearch/databases/dblist/default.htm> 
 
 
 

FirstSearch:  Highlighted Search Terms Will Be Available 
 
OCLC recently announced that highlighting of search terms is scheduled to become available in 
the OCLC FirstSearch service following an install on July 10, 2005. 
 
From the Options link in FirstSearch you can turn highlighting off, on, or choose multiple colors, 
which highlights multiple terms in different colors. From the Options link in FirstSearch you can 
turn highlighting off, on, or choose multiple colors, which highlights multiple terms in different 
colors. 
 
The highlighting is done by finding terms in the main body of the full bibliographic record only 
(not the brief record, and not the banner of some records).  The purpose of this feature is to 
improve the FirstSearch user experience by allowing a user's search term to "pop out,” making it 
clearer and faster as to why a record matched a particular search.  In rare cases, record 
formatting may prevent highlighting. 
 
You can preview what a FirstSearch record looks like when the highlighting feature is turned on 
at: 
 <http://www.oclc.org/news/announcements/announcement168.htm> 

http://www.oclc.org/support/documentation/firstsearch/databases/dblist/default.htm
http://www.oclc.org/news/announcements/announcement168.htm
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DIGITIZATION & PRESERVATION 
 
 

CONTENTdm Migration Training Session 
 
A third Web-based user migration training session has been added for the latest release of 
CONTENTdm.  A full feature list for Version 4 has been posted on the User Support Center.  There 
you will also find a PowerPoint presentation demonstrating these features and a recording of the 
Web-based user meeting held in early June. 
 
The third user migration training session will be held on Tuesday, July 26 from 1:00-3:00 p.m. 
(Eastern Time). The July 12 session is now full; however, there are still openings in the July 20 
session. The sessions will cover migration steps for upgrading to CONTENTdm 4 and 
implementation tips.  The sessions will also include time for your questions. 
 
To signup for a Web session, follow the registration instructions below. You do not need any 
special equipment to participate; all you need is a computer with an Internet connection and a 
telephone. Please share this information with others in your organization who are involved with 
CONTENTdm projects.  
 
Registration 
To register, please go to the registration page for the date of your choice (select one). Be sure to 
access the complete URL (each URL ends with =cdmtraining##, with the ## replaced by a 
number).  
               

•  Wednesday, July 20, 2005 3:00 - 5:00 PM ET 
<https://www3.oclc.org/app/request/bin/request.asp?specialCode=cdmtraining20> 

 
•  Tuesday, July 26, 2005 1:00 - 3:00 PM ET 

<https://www3.oclc.org/app/request/bin/request.asp?specialCode=cdmtraining26>  
 
If you are attending as a group with others from your organization (using a single phone line), 
only one person needs to register. This will allow us to make slots available to other CONTENTdm 
users. 
 
Details for logging onto the CONTENTdm Web meeting will be sent after you register. If you have 
questions about using MS Live Meeting, please contact Terri Dawson 1-800-848-5878, ext. 6251, 
or dawsont@oclc.org. 
 
OCLC; edited 
  

https://www3.oclc.org/app/request/bin/request.asp?specialCode=cdmtraining20
https://www3.oclc.org/app/request/bin/request.asp?specialCode=cdmtraining26
mailto:dawsont@oclc.org
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Contact Information 
   
MINITEX Bibliographic and Technical Services (BATS), 612-624-4002, 800-462-5348, 
mino@othello.minitex.umn.edu  (Carla Dewey Urban, Virginia Dudley, Carlos Portillo, 
Sara Ring, Mark Wilhelmi) 

OCLC Cataloging, ILL, Digitization and Preservation products and services 
 
Karen Docherty, MINITEX Cooperative Purchasing & Electronic Resources Services 
(CPERS), 612-624-2924, 800-462-5348, kdochert@umn.edu 

OCLC Reference products and services  
 

Cecelia Boone, 612-624-6353, 800-462-5348, c-boon@umn.edu   
Dave Linton, 612-624-3360, 800-462-5348, linto001@umn.edu   

OCLC Union Listing, including MULS 

mailto:mino@othello.minitex.umn.edu
mailto:kdochert@umn.edu
mailto:c-boon@umn.edu
mailto:linto001@umn.edu


 
MINITEX Calendar of Training, Meetings, and Conferences 

July 2005 
(Updated July 5, 2005) 

 
This calendar primarily lists events scheduled by MINITEX, although other events are included.  
This is an informational posting only, registration materials are sent separately.  If you are 
interested in attending a workshop and have not received registration materials two weeks prior to 
the event, contact the MINITEX Office (612-624-4002, 800-462-5348).  For OCLC training 
sessions, ask for Kay Kirscht.  There is a registration fee for many of the events listed. 
 
Some events listed on the calendar may be cancelled due to lack of registered participants.  
Cancellations and changes are highlighted by **CANCELLED** following the date of the event. 
 
This calendar will be updated and posted at the beginning of each month.  If you would like your 
event included in the calendar, please call Kay Kirscht at 612-624-3532. 
 
 
AUGUST 

 
10-11  Branch Out 2005 
  University of Minnesota, Duluth 
  Duluth, MN 
  www.branchout.org 
 
 

SEPTEMBER 
 
9 MINITEX Advisory Committee 

MINITEX, Conference Room 18 
Minneapolis Campus 
Minneapolis, MN 
 

19  Medical Library Assn., Midwest Chapter Annual Conference 
  Holiday Inn, Fargo 
  3803 13th Ave. S., Fargo, ND 
  http://midwestmla.org/2005conference/ 
 
21-23  2005 MLA Conference 
  The Depot 
  Minneapolis, MN 
  http://www.mnlibraryassociation.org/Annual_Conference.htm 
 
21-23  2005 NDLA Conference 
  "Providing Excellence in Information Access @ North Dakota Libraries" 
  Holiday Inn & Ramada Inn 
  Grand Forks, ND 
  http://ndsl.lib.state.nd.us/ndla/05conf.htm 

http://midwestmla.org/2005conference/
http://www.mnlibraryassociation.org/Annual_Conference.htm
http://ndsl.lib.state.nd.us/ndla/05conf.htm
http://www.branchout.org

